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Loading

How to Load an 1. Open the Load Window (Menu>File>Load Sequence or Ctri+L)
Image Sequence

into track X
2. Click on the Browse button for track X
3. Navigate the file systems to find your sequence and select any frame, click ok.
Start All p
4. Click the Start Button in the Load Window
OR
1. Drag and drop a single file from the sequence into the viewport. The sequence
will be loaded into whatever track is assigned to that viewport. If the Load
Window is open, only the preview will be loaded until you click the START
button.
OR
1. Drag and drop a folder into the viewport. The first sequence found will be
loaded into whatever track is assigned to that viewport. If the Load Window is
open, only the preview will be loaded until you click the START button.
OR
1. Drag and drop a single file or folder into a track in the main window.
How to load only a 1. Follow steps 1 through 3 of How to Load an Image Sequence into track X on
certain range of an p2

image sequence
2. Drag the In and Out sliders in the corresponding track in the Load Window

Ir
ot
Start All )
3. Click the Start Button in the Load Window
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How to Load a
Sequence as a
lower res proxy

1. Follow steps 1 through 3 of How to Load an Image Sequence into track X on
p2.

2. Before pressing Start, select or type in a scale in the Scale Box for the sequence
you are loading, select the filtering you want to apply when resizing the image

(linear=fast, bilinear=better looking) . Linear (Ughefa
Start All p
3. Click the Start Button in the Load Window
OR

1. Drag and drop a a single file from the sequence into the viewport while pressing
the shift key. The sequence will be loaded into whatever track is assigned to that
viewport at 50%. If the Load Window is open, only the preview will be loaded
until you click the START button.

How to Load Y
number of
sequences into
several tracks

1. Follow steps 1 through 3 of How to Load an Image Sequence into track X on
p2 with up to four tracks (A, B, C and D).

Start All )
2. Click the Start Button in the Load Window

How to load only a
specific region of
an image
sequence.

1. Follow steps 1 through 3 of How to Load an Image Sequence into track X.on
on p2

2. Activate the Crop Checkbox for that track in the Load Window m

3. Select the region you wish to load on the preview image shown in the Main
Window. Click and Drag to move the Crop Region, Click and Drag the
white corner markers to resize the Crop Region. You can zoom and pan
with the left mouse button and mouse wheel.

Start All )
4. Click the Start Button in the Load Window
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How to Load an Note that this will store images in 16 bit in memory, allowing greater precision
image with 16 bit when modifying 16 bit per component images with JefeCheck’s FXs at the
floating point cost of double the memory usage. (you don’t need to do this to simple load
precision and playback 16bit per component images, ONLY do it if you are

experiencing problems when doing heavy processing)

1. Follow steps 1 through 3 of How to Load an Image Sequence into track X.on
on p2

2. Select Half Float or 16bpc from the Format Option Box in the Load Window.

HALF

Start All P
3. Click the Start Button in the Load Window

How to cancel 1. Click on the white X stop button next to the track in the Main Window. The X
loading of a button will only be enabled when a track is being loaded.
sequence
How to start 1. Alt+Left Click on the timeline to start reloading all tracks from that point
loading a forward. This is useful when you need to check a very long sequence but are
sequence from a not sure where the frames that you are interested in start and you can not fit
certain point in the the whole sequence into RAM.
timeline

OR

2. Press alt+l to set the IN point for the timeline and start loading all tracks at
that point.
OR

3. Alt+Left Click on a specific track to start loading only that track from that
point forward.
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Change the layout
of the viewports

Playback

Click on any of the layout radio buttons in the Main Window’s Control Bar.
Or use keyboard keys 1 through 4 while holding the ctrl key to go through

the different layouts.

How to change
what track is
displayed on each
viewport

Select the track you want to show (A,B,C or D) in the corresponding

viewport’s Track Option Box in the Main Window’s Control Bar. A
OR
Press keyboard keys 1 through 4 to select tracks A through D

OR

Press keyboard keys up or down to move through the tracks.

How transform a
viewport

Left click and drag on a viewport to pan.

Use the mouse wheel to zoom in and out. Pressing shift while zooming makes
the zoom 10x slower OR ctri+left click drag up and down for the same effect.

If you press the alt key while doing any of this, transformations will apply to all
viewports (Gang Transformation).

If you don’t have a mouse wheel, you can zoom in and out by clicking and
dragging the viewport’s zoom box on the Main Window’s control panel. From
this box you can also change the pan values.

You can also flip and flop the image by clicking on the flip and flop buttons.

F|ip F|IZIFI

You can reset the transformation on a viewport by pressing ctrl+r on your
keyboard, or alt+r to reset all viewports.
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How to color 1. Select a LUT from the LUT listbox or press Up/Down while holding the L
correct a viewport key..

2. Adjust Gamma by inputting a value in the Gamma box or Dragging the
mouse left/right while holding the W key.

3. Adjust Exposure by inputting a value in the Exposure box or Dragging the
mouse left/right while holding the E key.

4. Adjust Brightness by inputting a value in the Brightnessbox or Dragging the
mouse leftright while holding the Q key.

5. Adjust Contrast by inputting a value in the Contrast box or Dragging the
mouse left/right while holding the D key.

6. Adjust Saturation by inputting a value in the Saturation box or Dragging the
mouse left/right while holding the S key.

7. You can reset the color correction on a viewport by pressing shft+r on your
keyboard, or alt+shift+r to reset all viewports.

8. You can also save a favorite color correction by pressing ctri+shift + 1,2,3,4 or
5 . Apply the color correction to anoher viewport at another time by pressing
shift+1,2,3,4 or 5.

OR

1. Apply one or more FXs like Primary Color Correction, Brightness-Contrast-
Saturation, Gamma, etc.

How to change the 1. Select or type in an aspect ratio in the viewport’s Ratio Option Box. File is the
aspect ratio of a default value, which maintains the original aspect ratio of the image.
viewport

2. You can change the aspect ratio of the image by placing black crop bars
instead of deforming it by clicking the Crop Bars Button to the left of the
Ratio Option Box.

3. Change the opacity of the crop bars in the View Menu
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How to see the
RGBA channels on
a viewport

—_

Toggle through the RGBA channels by pressing the RGB button, or use

shortcut keys R,G,B,A.

How to control the
playback

1. Click on the play/pause, tewind, fast forward, back one frame and forward
one.

2. Scrub the timeline by clicking and dragging the current frame notch on the
timeline or shift clicking and dragging on the viewport.

3. Click on the Playback Mode Radio Buttons to control if you want to play the
sequence once (Once) (shortcut 8), Loop it (Loop) (shortcut 9),, or play it
back and forth (Swing) (shortcut 10),

How to offset a
track on the
timeline

1. Click on the more options menu button (or right click on the track) next to the
track on the Main Window’s Control Bar .

2. Change the value of the track offset in the More Options Window for that
track. You can type in a number or click and drag to change the value.

OR

1. Click and drag the track to move it left or right

How to hold a
specific frame on a
track

1. Click on the more options menu button next to
the track on the Main Window’s Control Bar

2. Select an option from the Hold Frame Option currant
Box: Unload Trac edge

a. Current: Holds the current frame

b. edge: When the current frame number is smaller than the first loaded
frame on the track, the first frame will be shown. When the current
frame number is bigger than the last loaded frame on the track, the last
frame will be shown

c.  None: The track plays normally.
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How to unload a 1. Click on the more options menu button next to the track on the Main
track Window’s Control Bar

2. Click on the Unload Track button.
OR

1. Click on the unload track from the L.oad Window.

How to show or 1. Press the shortcut key t to toggle display of information text on the viewport,
hide text of press alt+t to toggle it on all viewports
information

2. If the track has a DPX, EXIF or OpenEXR metadata, it will be shown.

How to show DPX 1. If the track has a DPX image sequence loaded, you can display the DPX
Metadata on the metadata for each frame by pressing the shortcut key t until the appropriate
viewport text display mode is activated (text display modes are none, normal and
normal+metadata).
Processing
How to Load a 1. Open the FX Manager Window (F3 or menu>dialogs>FX Manager).

JefeCheck FX
2. Click the Browse Button

3. Select one or more .jfx files

4. If you want to have the FX autoload next time you start JefeCheck, click on
the auto-load checkbox next to the FX’s name (on by default).

How to Load a LUT 1. Open the LUT Manager Window (F4 or menu>dialogs>LUT Manager).

2. Click the Browse Button
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3. Select a .cube, .cub, .lut, or .tga file.

4. If you want to have the LUT load automatically next time you start JefeCheck,
click on the auto-load checkbox next to the LUT’s name (on by default).

How to apply one
or more FXs to a
viewport’s FX
stack

1. Open the FX Control Window (F2 or menu>dialogs>FX Stack Manager)
2. Click on the Viewport where you want to apply the FX

3. Select the FX you want to apply from the Available FXs menu in the FX Stack
Manager Window.

4. Turn the FX on or off by clicking on the on/off checkbox on the FX’s

controls. @

5. Repeat steps 3 and 4 for each FX you want to add.

How to change the
position of an FX
in the FX stack

1. Click on the Up E or Down button on the FX’s controls.

How to start a
JefeCheck Remote
Session Server

Remote Session

1. Open the Remote Session Manager Window (F6 or menu>Remote
Session>Session Manager).

Start Server

Hame JefeSenver] port 4420 pasanard

Senver IP:Fart

2. In the Start Server section of the Manager fill in the necessary information:
a. Type the server’s name in the Server Name Text Box

b. Type the port the server should listen on (32000 and above
recommended) in the Port Text Box
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c. Type a password in the Password Text Box (optional but
recommended)

3. Click the Start Button

How to join a 1. Open the Remote Session Manager Window (F6 or menu>Remote
JefeCheck Remote Session>Session Manager).
Session Server

Connect to Server

IF localhost port 4420 pasang

Mickname Gollas Colar 2 Connect

2. In the Connect to Server section of the Manager fill in the necessary
information:

a. Type the server’s IP address

b. Type the port where the server you are connecting to is listening
c. Type a password in the Password if the server requires one

d. Type in a Nickname to identify yourself in the session

3. Click the Connect Button

How to Chatin a 1. Connect to a Remote Session
Remote Session
2. Pressy to go into Chat Mode
3. Type in your message

4. Press enter to send the message.

5. You can also navigate the previous messages by pressing up or down on the
cursor keys on your keyboard.

6. You can exit chat mode by pressing the Escape key
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How to use 1. Connect to a Remote Session
Remote Pointers in
a Remote Session 2. Right Click and drag anywhere on the viewport’s area, everybody will see your

cursor with your Nickname next to it.

How to Save a 1. Connect to a Remote Session
Chat from a
Remote Session 2. Chat

3. When you are finished, click on menu>File>Save Chat Log

4. Select where you want to save your session and type a filename




